Microsoft®

Offic

@

2021
acs

dummies

A Wiley Brand

sheets .
e e - . Collaborate with other

e Microsoft Office users

200 267 390 296 248
89 102 120 117 107
18 24 28 25 22 P

Discover the shortcuts
that make working easier

Create spreadsheets, slide
decks, and documents

Bob “Dr. Mac” LeVitus

Healer of Macs

Dwight Spivey

Mac fan who loves Office






[ ~ "~ Y

060

Microsoft
Office 2021
For Macs

by B b L V t
ston columnist

d Dw ght Sp ey

dummies
A Wiley Brand



Microsoft® Office® 2021 For Macs® For Dummies®

Published by: John Wiley & Sons, Inc., 111 River Street, Hoboken, NJ 07030-5774, www.wiley.com
Copyright © 2022 by John Wiley & Sons, Inc., Hoboken, New Jersey

Published simultaneously in Canada

No part of this publication may be reproduced, stored in a retrieval system or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording, scanning or otherwise, except as permitted under Sections
107 or 108 of the 1976 United States Copyright Act, without the prior written permission of the Publisher. Requests to
the Publisher for permission should be addressed to the Permissions Department, John Wiley & Sons, Inc., 111 River
Street, Hoboken, NJ 07030, (201) 748-6011, fax (201) 748-6008, or online at http://www.wiley.com/go/permissions.

Trademarks: Wiley, For Dummies, the Dummies Man logo, Dummies.com, Making Everything Easier, and related
trade dress are trademarks or registered trademarks of John Wiley & Sons, Inc. and may not be used without written
permission. All other trademarks are the property of their respective owners. John Wiley & Sons, Inc. is not
associated with any product or vendor mentioned in this book. Office 2021 For Macs For Dummies is an independent
publication and has not been authorized, sponsored, or otherwise approved by Apple, Inc.

LIMIT OF LIABILITY/DISCLAIMER OF WARRANTY: WHILE THE PUBLISHER AND AUTHORS HAVE USED THEIR
BEST EFFORTS IN PREPARING THIS WORK, THEY MAKE NO REPRESENTATIONS OR WARRANTIES WITH RESPECT
TO THE ACCURACY OR COMPLETENESS OF THE CONTENTS OF THIS WORK AND SPECIFICALLY DISCLAIM ALL
WARRANTIES, INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. NO WARRANTY MAY BE CREATED OR EXTENDED BY SALES
REPRESENTATIVES, WRITTEN SALES MATERIALS OR PROMOTIONAL STATEMENTS FOR THIS WORK. THE FACT
THAT AN ORGANIZATION, WEBSITE, OR PRODUCT IS REFERRED TO IN THIS WORK AS A CITATION AND/OR
POTENTIAL SOURCE OF FURTHER INFORMATION DOES NOT MEAN THAT THE PUBLISHER AND AUTHORS
ENDORSE THE INFORMATION OR SERVICES THE ORGANIZATION, WEBSITE, OR PRODUCT MAY PROVIDE OR
RECOMMENDATIONS IT MAY MAKE. THIS WORK IS SOLD WITH THE UNDERSTANDING THAT THE PUBLISHER IS
NOT ENGAGED IN RENDERING PROFESSIONAL SERVICES. THE ADVICE AND STRATEGIES CONTAINED HEREIN
MAY NOT BE SUITABLE FOR YOUR SITUATION. YOU SHOULD CONSULT WITH A SPECIALIST WHERE APPROPRIATE.
FURTHER, READERS SHOULD BE AWARE THAT WEBSITES LISTED IN THIS WORK MAY HAVE CHANGED OR
DISAPPEARED BETWEEN WHEN THIS WORK WAS WRITTEN AND WHEN IT IS READ. NEITHER THE PUBLISHER
NOR AUTHORS SHALL BE LIABLE FOR ANY LOSS OF PROFIT OR ANY OTHER COMMERCIAL DAMAGES, INCLUDING
BUT NOT LIMITED TO SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR OTHER DAMAGES.

For general information on our other products and services, please contact our Customer Care Department within
the U.S. at 877-762-2974, outside the U.S. at 317-572-3993, or fax 317-572-4002. For technical support, please visit
https://hub.wiley.com/community/support/dummies.

Wiley publishes in a variety of print and electronic formats and by print-on-demand. Some material included with
standard print versions of this book may not be included in e-books or in print-on-demand. If this book refers to
media such as a CD or DVD that is not included in the version you purchased, you may download this material at
http://booksupport.wiley.com. For more information about Wiley products, visit www.wiley.com.

Library of Congress Control Number: 2022934336

ISBN 978-1-119-84044-2 (pbk); ISBN 978-1-119-84046-6 (ebk); ISBN 978-1-119-84047-3 (ebk)


http://www.wiley.com
http://www.wiley.com/go/permissions
https://hub.wiley.com/community/support/dummies
http://booksupport.wiley.com
http://www.wiley.com

Table of Contents

INTRODUCTION ... 1
AbOUL ThiS BOOK. . ..o e e e 1
Foolish ASSUMPLiONS. . ..ot eeeeee 2
lconsUsedinThisBoOK .. ...t e 2
Beyond the BoOK. . ...t i e 3
Whereto GofromHere ....... ..o i 3

PART 1: INTRODUCTION TO MICROSOFT

CHAPTER 1:

CHAPTER 2:

CHAPTER 3:

OFFICE FORMAC ... 5
Overview from 10,000 Feet ............................. 7
The Many Faces of OfficeforMac......... ... .ot 7
Installing Office .. ... 9

Getting a Microsoftaccount. ... 9
Downloading and installing Office ........... . ... ... 0. 9
Keeping Your Apps Up-to-Date............ ..ot 11
A Sweet Suite: Introducing the Office Apps......... 13
What's New and Good ..ottt 15
Thesuitelife. ... 15
IV Ord . 18
POWerPOINt. ..o e 18
EXCel oo 19
OULIOOK . ot 19
What's NewbutBad .......... i i e 20
Together, They're Better. . ...t i e 21
Common Features in All Office Apps................. 23
Using Menus in Office APPS. . .o v it 23
Toolbars, Ribbons, and Panes: Think “Visual”Menus .............. 25
The Quick Accesstoolbar. ... 26
Revelingintheribbon...... ... ... . o i i 26
Panes are anythingbutapain........... ... . ... ... 28
Customizing the Quick Access Toolbar, Ribbon Tabs,
and Keyboard Shortcuts. .........oo i 29
Customize the Quick Accesstoolbar ......................... 29
Customize ribbontabsandmenus. .............. ... ... 30
Creating ribbon tabsand tab groups.......................... 32
Customizing keyboard shortcuts .............. ... .. ... ... 32

Table of Contents iii



iv

Creating and Saving Documents. ..., 34

Using the gallery to open templates or recent documents. ... ... 34
Saving a document . ...t 36
Saving and Using DocumentsintheCloud....................... 39
Saving a file on a OneDrive or SharePoint location ............. 40
Sharing a file you've saved using OneDrive or SharePoint....... 41
Opening a file you've saved on your OneDrive or
SharePoint location. ....... ... 41
Understanding App Preferences. .........cooviiiiinniiiinnan. 42
App preferences: Why?. . ...t 42
App preferences: HOW?. . ..ot 42
Help: It's more than just a Beatles movie...................... 44
Official Microsoft websites. .............c i, 46
PART 2: MASTERING MICROSOFTWORD .................... 47
cuarrer 2 Getting to Know MicrosoftWord ..................... 49
Using a Variety of Versatile Views . .. .........coiiiiniiiinn, 50
Printlayout View . ...t e 51
Web layout VIEW. . .. oo e 51
Outlineview ... 53
Draftview ... ..o 54
Focusview ... ... 54
FullscreenView ... 56
Immersive reader View . . ...t 57
ZOOM, ZOOM, ZOOM t . vttt ettt et et eae s 58
Getting around in Your Document............ ... oo, 59
A scroll new world: Navigating by using the
mouse or trackpad . ... i e 59
Navigating by using keyboard navigation ..................... 61
CHAPTER 5: Creating Documents.................................... 65
Adding Text and Graphics to Your Document. .................... 65
Entering textinyourdocument ........ ... ... oo 66
Inserting an image in your document ........... ... . ... 66
Selecting Text for Editing and Formatting . ....................... 71
Formatting Text, Paragraphs,and Images. ....................... 74
Changing the look ofthefont ....... ... . ... . i, 74
Changing the look of paragraphs .......... ..., 76
Changing the look ofimages......... ..., 79
Copying Words and Images from Other Sources.................. 83
Dragging and dropping. . . ..oovet it 83
Copying and pasting . .. ..ovvun et 84
Working with Other Document Elements ........................ 85
Adding elements by using theribbon ........................ 86

Microsoft Office 2021 For Macs For Dummies



CHAPTER 6:

CHAPTER 7:

Modifying elements by using the ribbon...................... 87

Removing elements. . ... it 87
Refining and Editing Documents with Word. ....... 89
Moving Text and Images in Your Documents..................... 90

Moving items easily withinadocument....................... 90

Using special Word features that make moving stuff easier ..... 91
Check It Out: Checking Your Spelling, Grammar,
and Hyphenation. ... ... . i i e 93

Double-checking your spelling and grammar.................. 94

Utilizing Word's built-ineditor. . .......... ..o, 95

Correcting your errors automatically with AutoCorrect ......... 98

Hypnotic hyphenation ........ ... ... i, 101
Discovering the Reference Tools. . ...... ..., 102

The thoroughly terrificthesaurus........................... 102

The online referencetools........ ..., 104
Saving Time with the Find and Replace Feature.................. 108

Finding and replacingtext . ..........oviiiinei .. 108

Using Find and Replace to make formatting changes.......... 109

Using advanced search optionstodomore .................. 110

Using Templates and Other Design Elements. .. .. 113

Canned Design: Working with Word Templates.................. 114
Getting started with the Document Gallery................... 114
Sample project: Starting a custom newsletter
fromatemplate..... ... 114
Creating a customized version of a Word template............ 116
Saving your customized template.......... ... ool 116

Adding Basic Design Elements to Your Document................ 118
Imagine that: Adding and resizinganimage.................. 119
Moving images around documents .............ccoiiiiiin.. 119
Creating headersand footers ............ccoviviiiinaa.n. 121
Adding lines to your header orfooter ....................... 124
Arranging text with some help fromtabs .................... 125

Setting Tabs, Margins, and Other Types of Indents ............... 126
Setting tabs. . ..o o 126
Making your margins . ........ooiii i 129
Workingwithindents ... 130

Columns and Lists and Text Boxes (Oh,My)..................... 132
Columncreation ...ttt 132
Lists made easy (@nd pretty) . ....covvieiinne i 134
Text anywhere withtextboxes .......... ... ... ... 135

WorkingwithTables ....... ... o 136
Creatingatable ... ... 136
Formattingatable....... .. .. i 139

Table of Contents A"/



cuarrers: This and That: Advanced and

Collaboration Features................................ 143
Going in Style: Defining Styles for Easy Formatting . .............. 144
The easy way: Defining a styleby example.................... 144
The harder way: Defining a style by dialog ................... 147
Customizing Interface Elements .............cooiviiiiinein... 147
Customizing ribbontabsandmenus........................ 148
Create ribbontabsandtabgroups........... ... ... ... ... 149
Customizing the Quick Accesstoolbar....................... 150
Customizing keyboard shortcuts ............ ..o, 152
Creating a Table of Contents Automatically ..................... 154
Using Collaboration Features ..., 157
Turning on the Track Changes feature....................... 158
Accepting or rejectingchanges . ..., 160
Addressing Envelopes and Creating Labels. . .................... 162
Creating and printinganenvelope.................coooo.. 162
Creatinglabels. ... ... ..o i 164
Creating Web Pages .. ..ottt e 167
PART 3: POWERFUL PRESENTATIONS
WITH MICROSOFT POWERPOINT............................. 169
cuarrero: Getting to Know Microsoft PowerPoint ............ 171
Viewing Slides with Various Views. .. ........ ... .o, 172
Normalview. ... ... 173
Slide sorter view. . ..ot 174
Slideshowview ....... .. 174
NOTES PAE VIBW. . . ottt et e e e 176
Presenter view. ........ .o 176
Reading VIeW . ...t e 177
Planning Your Presentation: A Few Tips for Making Your
Slide Shows Better. . ...t 178
Usethe 10/20/30rule. . ..o i 178
Startwithanoutline ....... .. ... i 179
cuaerer 10: Creating SlideShows . ................................ 181
Getting Started. . ... 182
Giving Your Presentation a Visual Theme ....................... 182
Usingathemeasis.......coouiiiiniiiin i, 182
Customizing a theme's colorsorfonts....................... 184
Using Laborsaving Slide Layouts. . .......ooviiiinneiiinneenn. 186
Mastering slidemasters. ..., 186
Working with title and textobjects............ . ... . oL 191

Microsoft Office 2021 For Macs For Dummies



Working with PowerPoint Objects ............. ... oot 193

Formattingtables ....... .. . 194
Creatingachart. ... ... i 196
Getsmart:UseSmartArt ... 199
More media: Adding images, movies, orsounds .............. 201
Using Quick Stylesand Effects............. ..ot 203
Aligning, arranging, and distributing objects. ................. 206
CHAPTER 11: Making Your Slide Shows Slng ........................ 213
Using Transitions to Create a Polished-Looking Presentation ... ... 214
Applying transitions . ... 214
Transition OptioNS . . ..ottt 216
Using Custom Animation . ...t 217
Animating text or graphics. . ... o i i 217
Animating a chart or SmartArt graphic ...................... 223
Creating Interactivity with Action Buttons....................... 224
Shareand Share Alike. . ...... ... i 226
Printinghard copy. ....ovoiii i 226
Exporting (saving) your presentations as files ................ 229
cuarter 12 Presentation Prowess ... 237
Working with the Basic PowerPointTools....................... 238
Ribbon and Quick Access toolbar customization.............. 238
Proofing and referencetools. .......... ... i 241
Commentingonslides ... 242
Templates and other miscellaneous tools.................... 244
Using Hyperlinks ... ..o e 244
Recording Narration ..ot 246
Making the Most of Your PowerPoint Presentation............... 247
Rehearsing and setting slide timings . ....................... 247
Using the presentertools. ...t nn. 249
Working with asingledisplay .......... ... .. oo it 250

PART 4: CRUNCHING DATA WITH MICROSOFT'S
MOST EXCELLENTEXCEL...............coo i 253
cuaerer 13: Getting to Know Microsoft Excel..................... 255
Interfacing with Excel's UserInterface.......................... 256
Understanding the Concept of Rows, Columns, and Cells ......... 257
Usingthe Views . . ..ot e 258
Navigating within Your Worksheets . .......... ... .. ... .. .... 258

Table of Contents Vi



viii

CHAPTER 14:

CHAPTER 15:

CHAPTER 16:

Crunching Numbers (and Data) with Excel ........ 261

Working with Templates. . ... 262
Choosingalocaltemplate ........ ..o, 262
Working with onlinetemplates .......... ... ..., 263

Entering, Formatting, and Editing DatainCells. . ................. 264

Copying and Pasting Data (and Formatting) between Cells ........ 266

AutoFilling Cells . ... 268

Understanding Formulas and Functions . ....................... 269
Creatingaformula. ... ... i 269
Keeping track of Excel formulas with Formula Builder ......... 270

Using the Error Checking Feature. ..., 273

Sortingand FilteringData ...ttt 275
Sorting data . ..o v et 275
Using filters to narrow your data searches................... 276

Findingand ReplacingData.........covviiiineiiinneiinan. 277

Enhancing and Printing Your Excel

Spreadsheets............................ 281

Creating and Formatting Charts .......... ... ... 282

Including Picturesand Shapes. ............coo i 285

Adding Formatting and Special Effects. ............... .. ... ... 288

Creating and Sorting Custom ListS .. .......ooiiiiin ... 291
Creatingacustom list. ...t 292
Sortingalist . ... 292

Adding Headersand Footers. ..........cooviiiiiiin .. 293
Creating a headerorfooter............cov it 293
Editing a headerorfooter ........ ... 294

Printing Your Spreadsheets. ........ ... ... o i 295
Preparing for printing with Page Setup ... ................... 296
Ready, set, print. ....ooi i 298

Advanced Spreadsheeting ............................ 299

Customizing EXcel . ..o e e 300
Preferences .. ... 300

Conditional Formatting. . ......ovii i i e 304

Naminga CellRange. ...ttt e 307

Working with Multiple Worksheets. .............. ... . ... ... 307

Hyperlinking . . ...t e 308

Collaboration and Revision Tracking (a.k.a. Change Tracking)...... 310
Saving aworkbookonline .......... ... .. i 310
Tracking your Changes . ......ooviiini e 312
Accepting and rejectingyourchanges ....................... 313

Microsoft Office 2021 For Macs For Dummies



PART 5: MICROSOFT OUTLOOK: MIRACULOUS

MANAGER OF MOSTTHINGS. ..., 315
CHAPTER 17: Getting toKnow Outlook.............................. 317
Taking a Quick Tour of Outlook. ... 318
TheMailmodule ...... ... i 318

The Calendarmodule............. o it 319
ThePeoplemodule....... ... 320

The Notes and Tasks modules. ......................oott. 320

CHAPTER 18: Emalllng withOutlook................................. 323
Setting Up Outlook forEmail. ... i 323

Setting up your email automatically......................... 324

Setting up your email accountmanually ..................... 327

Sending, Receiving, and Managing Your Email ................... 330

Creating and sending Messages . . .....ooveviiinneenneennn. 330

Receiving messages ...t i 336
Managingyouremail ....... ... i 340

cuaerer 10: M@naging Your Affairs with Outlook................ 345
Scheduling Eventswith Calendar ............ ... .o, 346
Managing Your Crew with the People Module ................... 353

Adding and removingcontacts ... 353

Working withcontacts ...t 356

Delving intothe Hometab............ ... i, 360

Tracking Progress with the Tasks Module....................... 363
Understanding Notes ... ...t 365

CHAPTER 20: Getting Advanced with Outlook ..................... 367
Customizing: It's Not Just for Hot Rods Anymore................. 367
Reducin'theribbon............oo o i 368
Concentratingon columns. . ...t 368

Hiding, showing, and rearranging interface elements.......... 369

The fast way to start an advancedsearch.................... 370

What's Your Preference? ... 371

Your personal preferences. ... 371

Roll over, Beethoven, and catch the email preferences ........ 373

Everything but the KitchenSync ........... ... .. o it 375

“New"” Outlook? Yes, Pleasel. ..., 376

Table of Contents  iX



X

PART 6: THEPARTOFTENS. ..., 379

CHAPTER 21:

CHAPTER 22:

CHAPTER 23:

Ten Unsung Office Features and

Microsoft AppsforMac................................ 381
The Developer RibbonTab. ....... ... .o i i 381
AMultitude of FONES .. ..ot 382
lcons Gallery. ...t 383
Import Outlook Archives ....... ... 384
Microsoft Teams . ...ttt e 384
Outlook Profile Manager ... 386
Microsoft Remote Desktop ... ..ouuiitiii i 386
MiCrosOft EAge . . . oottt e 387
MICrosOft TO DO . ot vttt e e 388
Microsoft OneNoOte . .. ..ottt e 388
Ten Timesaving Shortcuts and Tips

for Enhanced Productivity ............................ 389
Memorize Keyboard Shortcuts . ..., 389
Get to Know Your Preferences ..........c.ooviiinnneeiiiiiinnnn. 390
Save a DocumentasaPDFFile............. ... oo 391
Save Time by Using the Share => Email (as Attachment)

Menu ltem ..o e 392
FocusontheTaskatHand............ ... i, 393
Use the Open Recent Feature to Open Items from the Dock. . ..... 393
GetHelp ..o 393
Use Format Painter. ..... ..ottt 394
Speak Your Mind with Dictation ............. ..., 394
Don't Forget Your Free OneDrive . ... ...t 395
Ten Ways to Customize Office........................ 397
Modify the Quick Access Toolbar ..., 397
Modify Existing Ribbon Tabs and Tab Groups ................... 398
Create a New Ribbon Tab or Tab Group for Frequently

Used ComMmMands. ..o vee ettt e 399
Focuswith Full Screen ... ... e 400
Deal with Frequently Used Documents ............... ..., 401
Remove Unused Keyboard Shortcuts. . ...t 401
Change an Existing Keyboard Shortcut ......................... 402
Create a New Keyboard Shortcut . ..., 402
Create YourOwnTemplates .....covviiiin i 403
ExperimentwithDarkMode ..., 403
.............................................................. 405

Microsoft Office 2021 For Macs For Dummies



Introduction

ou made the right choice twice: Microsoft Office for Mac and this book.

Take a deep breath and get ready to have a rollicking good time. That’s right —
this is a computer book, but it’s fun. What a concept! Whether you’re brand-
spanking new to the Office suite or a grizzled Office veteran, we guarantee that
reading this book to discover the ins and outs of Office for Mac is fun and easy.

About This Book

Why write a For Dummies book about Office for Mac? Well, Office for Mac is a big,
somewhat complicated suite of productivity applications, so we made Office 2021
For Macs For Dummies a not-so-big, not-so-complicated book that shows you how
to perform the most common tasks you’re likely to perform using Office for Mac,
all without boring you to tears, confusing you, or poking you with sharp objects.

In fact, we think you’ll be so darned comfortable that we wanted the title to be
Office For Macs without Discomfort, the Very Comfortable 2021 Edition, but the pub-
lisher wouldn’t allow it. Apparently, we For Dummies authors have to follow some
rules, and using For Dummies and Office For Macs in this book’s title are among
them.

Speaking of dummies, we don’t think you’re dumb — quite the opposite! Our sec-
ond choice for this book’s title was Office For Macs For People Smart Enough to Know
That They Need Help Using It, but you can just imagine what the Wiley folks thought
of that. (“C’mon, that’s the whole point of the name!” they insisted. “Besides, it’s
shorter this way.”)

Anyway, the book is chock-full of information and advice, explaining everything
you need to know about Office for Mac in language you can understand — along
with giving you timesaving tips, tricks, techniques, and step-by-step instruc-
tions, all served up in generous quantities.
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Foolish Assumptions

Although we know what happens when you make assumptions, we’ve made a few,
anyway. First, we assume that you, gentle reader, know nothing about using
Office — beyond knowing what it is, that you want to use it, that you want to
understand it without digesting an incomprehensible technical manual, and that
you made the right choice by selecting this particular book.

And so we do our best to explain each new concept in full and loving detail. Maybe
that’s foolish, but, so be it.

Oh, and we also assume that you can read. If you can’t, just ignore this
paragraph.

Icons Used in This Book

2

©

TIP

@
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®

WARNING

Little round pictures (icons) appear to the left side of the text throughout this
book. Consider these icons miniature road signs, telling you a little something
extra about the subject at hand. Here’s what the different icons look like and what
they all mean:

Look for Tip icons to find the juiciest morsels: shortcuts, tips, and undocumented
secrets about Office for Mac. Try them all and impress your friends!

When you see this icon, you know that this particular bit is something we think
you should memorize (or at least write on your shirt cuff).

Put on your propeller-head beanie and pocket protector; these tidbits include the
truly geeky stuff. They’re certainly not required reading, but they must be
interesting or informative or else we wouldn’t have wasted your time with them.

Read these notes very, very, very carefully. (Did we say very?) Warning icons flag
important information. Neither the authors nor the publisher is responsible if
your Mac explodes or spews flaming parts because you ignored a Warning icon.
(Just kidding — that type of catastrophe won’t happen.) Macs don’t explode or
spew (with the exception of a few choice Michael Spindler—era models — true
Apple aficionados will know what we’re talking about). But we got your attention,
didn’t we? We tell you again: Read the Warning notes very carefully.

Microsoft Office 2021 For Macs For Dummies



Beyond the Book

There’s even more Office for Mac information on www.dummies.com. This book’s
cheat sheet shows you how to create automatic replies to senders in Outlook,
check documents for accessibility problems, embed fonts in your Word documents
and PowerPoint presentations when sharing, and even check the current weather
when viewing your Outlook Calendar. To get to the cheat sheet, go to www.
dummies.com, and type Office 2021 for Macs For Dummies Cheat Sheet in the Search
box. You’ll see not only the cheat sheet but any significant updates or changes that
occur between editions of this book.

Where to Go from Here

Go to a comfortable spot (preferably not far from a Mac) and look through
this book.

In the first few chapters, we describe the basic everyday topics you need to under-
stand to operate your Mac effectively. If you’re new to Macs and Office for Mac,
start with Chapters 1-3, which make up Part 1. The discussion in Part 1 is so basic
that if you’ve been using Office awhile, you might think you know it all — and you
might know most of it. But, hey! Not-so-old-timers need a solid foundation. So
read what you need and skip the rest.

What are you waiting for? Go — enjoy the book!
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IN THIS PART ...

Get an overview of the various versions of Office for
Mac as well as how to install and set them up.

Become acquainted with the four major apps in the
Office suite: Word, PowerPoint, Excel, and Outlook.

Explore Office features that work the same way in all
four apps, such as menus, toolbars, preferences,
and help.



IN THIS CHAPTER

» Deciding which of the editions of
Office for Mac to buy

» Signing up for a Microsoft account
» Installing Office

» Keeping your apps updated

Chapter 1

Overview from
10,000 Feet

ver the next several hundred pages, you can find out in detail about the

apps that make up the Microsoft Office for Mac suite. But first you must

decide which version of the suite you want or need, acquire a copy of it,
and then install it and find out how to update it to ensure that you’re always run-
ning the latest and greatest (not to mention most stable) version.

So, without further ado, dig in!

The Many Faces of Office for Mac

When it comes to choices, it seems Microsoft wants to make sure you have a ver-
itable cornucopia of them for Office apps. Combining the number of packages
available for individual and business use, there are roughly a dozen to choose

from. For simplicity’s sake, we focus on the several tasty flavors of Office for Mac
for individuals and home users:

¥ Office for Mac Home & Student

¥ Office for Mac Home & Business

CHAPTER 1 Overview from 10,000 Feet 7



¥ Microsoft 365 Personal
¥ Microsoft 365 Family

Office for Mac Home & Student and Office for Mac Home & Business are both one-
off purchases; you pay one price up front and then own it forever. Microsoft 365
Personal and Microsoft 365 Family offer a subscription model, in which you pay a
monthly or yearly fee, with access halting only when you choose to cancel or you
miss a payment.

The four editions all provide the big three apps — Word, Excel, and PowerPoint —
with variations based on whether you selected the Office or Microsoft 365 version.
The Microsoft 365 editions of the big three apps provide the latest features and
updates on a continual basis — Microsoft calls these premium versions. When
Microsoft develops and implements a new feature, you get it automatically, so you
apps are always up to date. The Office editions provide classic versions of the big
three — what you see is what you get, with no additions or updates except security
and bug fixes. You can’t take advantage of new features and products unless you
purchase the next Office edition Microsoft releases (they’re usually several years
apart).

Here’s the skinny on each of the four editions:

¥ Office for Mac Home & Student : The retail price is $149.99 for a single
installation. As the least expensive edition, it includes the big three apps and
OneNote. Many users need nothing more.

Note that this edition does not include Microsoft Outlook. Outlook, which is
sometimes called the Swiss army knife of personal communications software,
combines an email client with an address book, a calendar, to-do lists, and
searchable notes in a single app.

Unless you dislike the Mail, Contacts, and Calendar apps that are included
with macOS, you probably won't miss Outlook much.
TP ¥ Office for Mac Home & Business: The retail price is $249.99 for a single

installation. What do you get for the additional dough (along with the big
three and OneNote)? In two words: Microsoft Outlook.

What's that, you say? You don't know whether you need Outlook? Well then,
we suggest that you save yourself a bundle and start with the Home &
Student Edition.

8 PART 1 Introduction to Microsoft Office for Mac



Does your organization require or prefer that you use Outlook? It's best to
find out before you make a purchase. You can't simply pay a few more dollars

to upgrade from Office Home & Student to Office Home & Business; you'd
WARNING have to pay the full price of Office Home & Business to gain access to Outlook.

3 Microsoft 365 Personal: For the price of $69.99 annually or $6.99 monthly,
you get access for one person to premium versions of the big three, OneNote,
Teams, and Outlook, 1TB of OneDrive online storage (more on OneDrive in
the next chapter), and the ability to install and use your subscription on up to
five devices — Macs, PCs, iOS devices, and Android. That's right: five devices
with support for a variety of desktop and mobile operating systems!

3 Microsoft 365 Family: The price is $99.99 annually or $9.99 monthly for
access to everything in Microsoft 365 Personal. Plus up to six people can use
the subscription instead of one. You can also try it for free for one month.

So there you have it — four editions for four budgets.

Installing Office

Regardless of which edition you decide to buy, you’ll need a Microsoft account and
an internet connection to download the installation package for your apps.

Getting a Microsoft account

A Microsoft account is similar to your Apple ID; it’s an account for you to manage
your Microsoft apps and purchases. To download and install your Office apps,
your purchase of Office for Mac must be associated with a Microsoft account
(personal, business, or school account).

If you don’t have a Microsoft account, go to https://office.com/setup to
create one.

Downloading and installing Office

To install Microsoft Office, you need the username and password for an adminis-
trator account on this Mac. If you don’t have an administrator account and pass-
word handy, it would behoove you to get one now.

CHAPTER 1 Overview from 10,000 Feet 9
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After you have that detail settled, here’s how to download and install your
Office apps:

1. Goto https://office.com and sign in to the Microsoft account associ-
ated with your Microsoft 365 or Office purchase.
2. click the Install Office button and download the installer package.
3. Locate and double-click the installer package to launch the installer app.
4. click Continue on the first screen.
The screen displays the license terms.
5. Read every word of the license terms, and then click Continue.

e We're only half kidding — we know that no one reads the licensing informa-
6 tion. But because you're about to enter into a legally binding agreement, we

TECHNICAL would be remiss not to at least pretend to urge you to read every word.

STUFF
6. on the next screen, click Agree.

The Select a Destination screen appears.

7. Choose the destination disk for the software installation and then click
Continue.

The Standard Install on your hard drive’s name screen appears.

8.1 you want to install the Office apps somewhere other than the
Applications folder, click the Change Install Location button and select
another destination.

In the next step, you click Install. But if you're short on disk space, consider
@ not installing some of the apps. To do so, click the Customize button before
you click the Install button and then deselect any items you don't want to
TIP install.

9. click the Install button to open an authentication window, enter an
administrator name and password, and then click OK.

Go get yourself some coffee or a soft drink — the installation takes a bit
of time.

10. When the screen informs you that the installation is complete, click the
Close button and you're ready to go.

Head on over to your Applications folder and double-click one of the newly
installed Office apps to get started.
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DEALING WITH MULTIPLE VERSIONS
OF OFFICE

If you have an earlier version of Office on your hard drive when you install Office, the
older version isn't touched. You now have two (or possibly even three or more) Office
versions in your Applications folder.

In a perfect world, all your Office documents, both new and old, would launch the cur-
rent versions of Word (or other Office apps) when you open them. But in the real world,
this may or may not be your experience.

So, we offer you this little lesson in macOS file-opening mastery. You can cause a single
file or all files to open in a specific app in two ways. The first method is to right-click the
document, choose Open With from the contextual menu, and select an app. The second
method is to set a single file or all files of its type to open in a specific app, as follows:

1. To specify which version of Word, Excel, or PowerPoint opens when you double-
click one of its document files, single-click that document file and then choose
File => Get Info (or press 38+).

A drop-down Open With menu appears. If you don't see the Open With menu, click
the small, gray disclosure triangle next to the words Open With.

2. Click the Open With menu and select the version of the app you want to open when
you double-click this document.

3. If you want all documents of this type to launch this version of Word, click the

Change All button.

There you have it — if the wrong version of an Office app launches when you open a
document, you now know how to fix it.

Keeping Your Apps Up-to-Date

Microsoft AutoUpdate is a nifty app that’s installed along with your other Office
apps (although you won’t find it in your Applications folder). AutoUpdate does
what its name implies: It automatically searches for updates to your Office apps
and installs them.

CHAPTER 1 Overview from 10,000 Feet 11



To open AutoUpdate:

1. Open an Office app (such as Word or Excel).
2. Choose Help => Check for Updates from the menu at the top of the screen.

The AutoUpdate app launches and scans Microsoft's servers to check for
updates to any Microsoft apps you have installed (even apps that don’t come
with Office, such as Microsoft's web browser, Edge).

3. When updates are found, click the Update All button to download and
install all available updates, or click the Update button to the right of the
app’s name to only update that app.

4, (Optional) If you want AutoUpdate to periodically check for and install
updates automatically, select the box labeled Automatically Keep
Microsoft Apps up to Date.

5. Quit AutoUpdate when you're finished.

If you don’t elect to have AutoUpdate work automatically, be sure to check every
few weeks to a month to make sure you have the latest updates and fixes.

TIP
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IN THIS CHAPTER

» Exploring new features

» Introducing the four main Office apps

» Examining how the apps work
together

Chapter 2

A Sweet Suite:
Introducing the
Office Apps

(= =)
oS
TECHNICAL
STUFF

icrosoft Office for Mac isn’t a single, monolithic app that processes

words and numbers, creates slide shows, manages your email, calendar,

and contact database, and more. No, Office is a suite of programs that
share numerous interface characteristics so that many functions are the same
across all apps, making it easier for you to seamlessly move between them. The
programs are designed to work together harmoniously, adding up to a sum that’s
greater than its parts.

When you install the software, you don’t create a single app named Microsoft
Office for Mac, nor is there a single folder that houses all the installed apps.
Rather, you’ll find that each app is installed separately (in the Applications
folder, by default); they’re easy to find, though, because each starts with the word
Microsoft (Microsoft Word, Microsoft Excel, and so on). The lone exception is One-
Drive, which is simply named OneDrive.

You may have more or fewer Microsoft Office apps in your Applications folder. The

number depends on which edition of Office you purchased and which options you
choose during installation.
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TIP

The following list briefly describes the items that matter, focusing on what each
one is or does. Note that some of these may not be in your installer package,
depending on which version of Office you’ve purchased or subscribed to:

»

»

»

»

»

»

»

»

Microsoft OneNote: OneNote is a free-form digital note-taking app that can
be used to house those great inspirations that pop into your brilliant mind
from time to time.

Microsoft Excel: Excel is the number-crunching member of the Office family.
You use this program to create spreadsheet documents.

Microsoft Teams: Teams is a video-conferencing and collaboration tool
designed for organizational communications. It's very much like Zoom and
other such apps, but with a familiar Microsoft flair.

Microsoft Outlook: Microsoft Outlook is the Swiss army knife of Microsoft
Office apps — it includes not one, not two, but five separate functions. It's

An email client

An address book

An appointment calendar

A task and to-do list manager
A repository for notes

Microsoft PowerPoint: PowerPoint is the presentation-creating member of
the Office family. You use it to create slide shows.

Microsoft Word: Word is, of course, the Office word processing program. But
it's much more than that these days because you can use it to create almost
any document that contains text or images or both.

OneDrive: It seems that more and more apps and traditionally computer-
focused functions are taking place in the cloud these days, meaning these
things are web-based (living on the internet). OneDrive is Microsoft's version
of cloud-based storage and is similar to Apple’s own iCloud service.

You can find out more in Chapter 3 about using OneDrive, Microsoft's free,
cloud-based file storage service, for collaboration, co-authoring, and backups.

Microsoft AutoUpdate: It's important to keep your Microsoft apps updated

and in tip-top shape. AutoUpdate keeps you in the update loop by automati-

cally checking for updates periodically and even updating apps automatically,
if you so choose.
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What's New and Good

TIP

Microsoft Office for Mac has many new or improved features, but perhaps the
most important one is that the suite is now coded to run natively (although thank-
fully not exclusively) on Macs that have Apple Silicon processors. Office apps are
also built for Macs with Intel processors. The installer app will know which ver-
sion your computer needs during installation.

The system requirements have changed, too. Microsoft supports the three most
recent versions of macOS. When a new major version (not an incremental update)
of macOS is released, Microsoft picks up support for it and drops support for the
oldest. As of this writing, Office for Mac is supported for macOS Monterey, Big
Sur, and Catalina. When a newer version of macOS is released (a major version is
typically released on an annual basis in the fall), Microsoft will support it, Mon-
terey, and Big Sur, and drop support for Catalina.

We’ll stop calling the suite Office for Mac now and refer to it as just plain ol’ Office.
Because you’re reading this book, you should be using Office on a Mac. If you
aren’t a Mac user, you’re reading the wrong book.

There’s a lot more to Office, so let’s get to it. We start by describing what’s new
and good in the latest version of Office and continue with major new features
common to most or all of the programs that make up the suite. After that, you look
at new features and improvements specific to Word, PowerPoint, Excel, and Out-
look. The section concludes with a short rant on what’s bad or ugly in this release.

The suite life

All Office apps have received facelifts, so that’s a good thing all around. They still
look very macOS-like but incorporate the coloring and themes of their Windows
counterparts to make it easy to switch between platforms and still feel a sense of
familiarity. Figure 2-1 shows you the ribbon’s Home tab for Excel, Outlook, Pow-
erPoint, and Word. Note the color assigned to the Quick Access toolbar for each;
these are the same colors used for each app in Windows, i0S, and Android.

You can enable or disable certain ribbon features or change the order of its tabs by

choosing App Name=> Preferences=> Ribbon & Toolbar from the menu at the top of
the screen in every app.
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Throughout this book, we examine some of the new features available throughout
Office. For now, here’s an overview :

3 Co-authoring: Now multiple users can collaborate simultaneously on a single
Office document using different computers (Macs or PCs). Updates made by
other people appear on your screen in real time, and you can choose to be
alerted whenever other document collaborators are present. To use real-time
co-authoring, you and your collaborators must store shared files in OneDrive.
This feature doesn't work with the LTSC version of Office. LTSC, which stands
for Long Term Servicing Channel, is available only for commercial or govern-
ment clients.

¥ SharePoint and OneDrive: All Office apps support not just one but two
Microsoft cloud storage services. You can open and save documents stored
on either cloud from a Mac or a PC or one of the Office web apps.

Microsoft offers 5 gigabytes of free online storage space when you sign up

@ for its free OneDrive service at https://onedrive.com/. (This is the same
amount as Apple’s basic version of iCloud but a mere bagatelle compared to

TIP Google Drive's 15GB for a basic free account.) When you store documents on

your free OneDrive, you can not only open them using Office on a Mac or PC
but also edit them in a web browser using one of the Office web apps. If you
need more than 5GB of storage, you'll need to sign up for Microsoft 365,
where you can get up to 1TB (or 1,000GB!) of storage.
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FIGURE 2-2:
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¥ Office for the web apps: Open an Office document without a copy of Office?
You betcha. If the file is stored on your (free) OneDrive, you can open and edit
it in a web browser, as shown in Figure 2-2. This feature isn't exactly new but
has been updated immensely.
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3 AutoSave: If your document is stored in OneDrive, you can use the AutoSave
feature to instantly save any changes you've made, as well as make those
changes visible in real-time on other devices. This feature doesn’'t work on the
LTSC version of Office.

Many features mentioned in this section are available in Word, PowerPoint,
and Excel but not in Outlook. That's because many of these new features are
document oriented and Outlook is the only one of the four that doesn't create
its own documents.

¥ Graphics galore: Office offers a slew of new images, icons, and other
graphics, particularly via the web, to beautifully adorn your documents,
spreadsheets, and presentations.

3 Improved new document experience: Excel Workbook gallery, PowerPoint
Presentation gallery, and Word Document gallery provide quick access to
themes, templates, and recently used documents. Browse great-looking
previews to see what your document will look like before you start
working on it.

¥ Improved performance: Don't expect the Office apps to launch in under .005
seconds or to fetch your groceries, but they have been updated to open faster
and to work more efficiently than previous versions.
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Office has hundreds of other tweaks, fixes, new features, and improvements,
including many streamlined dialog boxes, toolbars, and panes, and better media
integration (with your pictures, movies, and music). We could probably write an
entire book about all the new and improved capabilities in Office. But the boss says
that we have to show you how to use everything, too, so we had best move
along now.

The following sections provide overviews of new features specific to the big four
Office apps — Word, Excel, PowerPoint, and Outlook.

Word

Word has been the primary tool we use to make a living for quite a while now
(we’re talking decades here). Word still feels like Word but offers several enticing
new features, such as

3 Enhanced dark mode: Dark mode was a feature in previous incarnations,
but the actual document remained a stark white. Now, even the documents
themselves utilize the dark background and themes, making dark mode that
much easier on the eyes.

3 More colors in immersive reader view: The immersive reader view now
supports several colors to help make things more interesting and allow for
customization.

3 Better voices in read aloud mode: You now have more lifelike and natural-
sounding voices to grace your ears when listening to Word read back the text
of your documents while using read aloud mode.

PowerPoint

Among the new features in PowerPoint, a few stand apart from the rest:

3 Animated GIFs of slide shows: The latest version of PowerPoint for Mac
allows you to save your presentations as animated GIFs, which make it easy to
share via platforms such as social media.

¥ Ink replay: Sometimes it's fun (and even necessary) to use the Draw tab to
draw on your slides to emphasize something. Wouldn't it be cool if your
audience could watch replays of you drawing (or “inking” as Microsoft calls it)
on your slides? With ink replay, you can incrementally show how your inkings
progress during the slide show, kind of like watching a mini-movie of you as
you made the drawings in real time.
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